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Module

3.1
Start working 
with text

What is a word processor used for?
A word processor is a computer program that is designed to create text-based 
documents. This includes letters, reports, fax cover pages, memos, brochures, 
minutes, advertisements and agendas.

The aim of word processing is communication. Content is therefore important. 
To ensure that the information is carried across effectively, the appearance of the 
document is just as important. Word processors have a variety of functions that can 
be used to lend a professional appearance to documents, and to ensure that the 
message comes across clearly.
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Meet the working environment
When you load or open Word, the word processing screen is presented as a blank 
page on which you can start to type. 

At the top of the window you will find Word’s Ribbon. It contains all the facilities of 
Word organised into a number of tabs. Each tab in turn contains a set of related 
commands divided into groups.

The Home tab, for example, contains the commands that one usually needs first in 
creating a new document.

There are also tabs that are 
displayed only when you are 
working with certain objects, such 
as pictures or tables. They appear 
only when such objects are 
selected, i.e. clicked upon.

The Quick Access Toolbar is 
normally above the Ribbon and 
contains your most frequently 
used commands.

The toolbar can be 
customised. Click on the 
small arrow at the right, 
and select which objects 
should appear on the 
toolbar.

Word 2007

Word 2010
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How to work with files 
Computer files are used to store everything we wish to save on a computer.

The Office Button (Word 2007) or the File tab (Word 2010), in the top left corner, 
opens a drop-down menu that contains file-related commands. These can be used to 
open and save files, and to print out your work.

 For the tasks that follow we are going to start by opening this menu. (You can also 
press <Alt><F> to open it.)

Create and save 
Opening a new blank document

When Word is loaded, a blank document in which you can type will usually appear. If 
you need to create a new document, proceed as follows:

	 Select New and then Blank document. 

File tab of Word 2010

Office Button of Word 2007

A new file is created in the 
memory. The document you are 
creating is situated in the memory 
(RAM) and isn’t automatically 
stored on the disk.
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Saving a new document for the first time
	 Select Save or Save As. 

	 Select the correct drive and folder.

	 Type in the name of the document.

	 Click on Save.

The file is saved on 
the disk under the 
given file name. A 
copy now exists in the 
memory as well as 
on disk.

The copy in RAM (with 
changes) is written to 
the disk. 

The existing copy on 
disk is overwritten when 
the identical file name is 
used. 

Saving an existing document under the same name and in the same 
location 

	 Select Save.        

Saving an existing document under a different name or in a different 
location

	 Select Save As.

	 Select the correct drive and folder. 

	 Type in the name of the document.

	 Click on Save.

The copy in RAM (with 
changes) is written to 
another place on the 
disk. 
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Opening an existing document
	 Select Open. 

	 The Open dialog box will appear.

	 Select the correct drive / folder. 

	 Select the correct file name.

	 Click on Open.  

Work on copy in RAM. 
Changes are made here.

Copy of file on 
disk to RAM.

Display of a document
Sometimes you struggle to read the text in a document easily, 
because it appears too small on the screen. On the View tab 
there are various display options that you can use in order to 
increase or decrease the viewing size of the document.

When we create a new document, it displays automatically in Print Layout (as it 
will be printed). In the Document Views group there are also other display options.

Printing a document
To print a document:

	 Select Print. 
(A print dialog box or window will 
appear.)

    	Here you can indicate, among other 
printing options, which pages must be 
printed, as well as how many copies.

	 Select the desired options.

	 Click on OK (Word 2007) or Print 
(Word 2010).

Important!		

Look at the preview of the document to 
check the layout of the document before 
you print!

Only print the document once you are 
completely satisfied with the layout, spelling, etc.

This saves paper, ink and money!



Module 3:1: Start working with text 159

Inserting symbols
Over and above the normal characters on the keyboard, there are 
all sorts of symbols that can be added to a document.

	 Add other symbols to your document as follows:

	 Click on the Insert tab and then on Symbol in the Symbols group.

	 Click on More Symbols… and select the Font that you want to use.

	 Click on the desired symbol.

	 Click on Insert.

	 Click on Close.

Creating a document 
To create a new document, start simply by typing on the blank page that appears 
when Word is opened. File, New can also be used to begin a new document.

Entering text
The Enter key should only be used at the end of a paragraph. You should therefore 
continue typing when you come to the end of a line. The words will automatically move 
down to the next line as needed. This feature is called word wrap. When you do press 
<Enter> to begin a new paragraph, Word will automatically leave a little extra vertical 
space between the new paragraph and the previous one.  

There must always only be one space between adjacent words. In front of a 
punctuation symbol such as a comma or a full stop there must not be a space. After a 
punctuation symbol, however, there must always be a space.

Type at least 80 words on one of the following:

•	 An amusing or memorable incident during your last holiday.

•	 A short summary of the last movie you saw.

•	 A description of an interesting place you visited recently.

•	 Complete the following: Computers can do things today that were not even dreamed 
about 20 years ago. In another 20 years, computers will …

Activity 1

Word fortunately has an ‘eraser’ if you have made a typing error. Use 
the Backspace key to remove characters to the left of the cursor, and the 
Delete key to remove characters to the right of the cursor. 

The Undo command is very useful if you want to undo / reverse things that you have 
done. The easiest way to do this is simply to press <Ctrl><Z>. The Redo command 
(<Ctrl><Y>) cancels the Undo command. You can also use the Quick Access Toolbar.
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The Wingdings (and Webdings) 
font types have a number of 
interesting symbols that can be 
included in documents.

Select the same font as that of 
the surrounding text.

1.	 Open the document Diacritics. It already contains two paragraphs. Add the 
examples, as shown below, and save it again.

Activity 2

In simple cases the 
Tab key can be used 
to align sections of 
text neatly below each 
other. 

Never use the space 
bar for this purpose!
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Hidden formatting symbols

Tab

Spaces

Enter

Click on ¶.

Simply click on Show/Hide ¶ once more to hide these 
characters from view.

2.	 Practise the use of symbols by typing the following in a new blank document. Save 
your document as Symbols.

	 ( 	 (011) 783-1090		  	 0828700987

	 	 (011) 783-6432	 	 ¼ + ½ = ¾

	 3  + 2  ≥ 50 (Hint: use the font type Cambria Math.)

	  is the symbol that indicates the end of a paragraph

	 Input Devices: Keyboard   and mouse 

	 The electrical resistance is 3  	 ABC = 30°

Every character that 
you type is stored as a 
particular code on the 
computer. Even if you 
press the space bar, 
the code for a space is 
registered!

The hidden formatting 
symbols will be 
displayed when 
you click on ¶ in the 
Paragraph group. It 
is sometimes useful, 
as you can then see 
where you used the 
Space Bar, Enter or 
Tab keys.
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Character formatting
We can make the content of our documents appear 
differently. This is called formatting. Word contains 
instructions that can be used to format any element in 
a document. We begin by looking at the formatting of 
ordinary characters or text.

Open the document GrassGreener.

Round off the document neatly, taking careful note of the following: 
•	 There must be a single space between each word.
•	 There must be no space before a punctuation mark such as a comma or a full stop.
•	 There should, however, be a space after a punctuation mark.

Hint:  You can make this task a lot easier by displaying the hidden formatting symbols 
when working with the document.

Activity 3

Character formatting 
is the altering of the 
appearance of characters/
text. In other words, it is 
the manner in which it is 
displayed in terms of form 
and size, colour, etc. 

Character type or font 
The word font refers to the design of characters 
which is constant across a set of letters, numbers and 
symbols. Take a look at the example.

There are many font types to choose from. Calibri 
was selected as the default font for Office 2007/2010 
because of its modern look and because it is well 
suited to documents that are mainly read on-screen. 
This means that the font of any new document will be 
Calibri by default, unless you change it.    

Fonts are classed into two main categories:

•	 Serif fonts

•	 Sans Serif fonts

The Cambria font type 
has short, decorative 
lines (serifs) at the 
beginnings and ends of 
the strokes that make 
up each character. It is 
therefore a Serif font. 

The Calibri font type is 
a simpler character type 
without any short lines at the 
beginnings and ends of the 
characters. We call this a Sans 
Serif font. (The French word 
sans means ‘without’.)

Examples of other fonts
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Character styles 
Different character styles are used to emphasize 
certain words or to recognise, for example, 
scientific names.

Character sizes 
The size of text is measured in ‘points’ 
(pt). The best size to use in A4 size 
documents is usually 10–12 pt.

Changing character type (font), size and 
style using the Font group.  

	 Select the text that you wish to change.

	 Choose the font type / font size / font 
style(s). 

The basic character formatting options 
as well as other options are 
available if you open the 
dialog box of the Font group. 
Remember to first select the text 
that you wish to format.

Normal text

Bold

Italic

Underline

Bold Italic

Character type

Character size

Character style

Open dialog box

Ways in which to select text 
with the mouse

•	 Place the cursor at the 
beginning of the section that 
must be selected. Hold down 
the left mouse button and drag 
the cursor to the end of the 
section.

 •	 A word can quickly be 
selected by double-clicking on 
it.

•	 Click in the white space at the left (i.e. 
in the margin) if you wish to select a 
horizontal line of text. The cursor will 
change to an open white arrow. 

•	 You can even select a number of non-
adjacent sections of text by holding 
down the Ctrl key while selecting each 
one in turn.
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Activity 4
1.	 Open the document Speed. Complete the formatting 

instructions as requested in the document.

2.	 Open the document Cyberkid. Format the document 
as described below, but for bold and italic you 
may use only the keyboard shortcuts <Ctrl><B> and 
<Ctrl><I>.

•	 The heading must be bold and have a font size larger than the rest of the text.

•	 The paragraph in bold must be changed to regular text.

•	 The two sub-headings (each begins with ‘In the 21st century’) must be bold.

•	 The ‘st’ of 21st must be superscript. 

•	 All the words and abbreviations typed in uppercase, must be bold.

•	 All the words in uppercase that are not abbreviations (e.g. WORK) must be 
changed to lowercase, and bold.

•	 All the dialogue (sentences in quotation marks) must be italic.

•	 All shading must be removed.

•	 The font size of the last sentence must be reduced, but still be larger than the 
rest of the text, and changed to small caps. The italics must also be changed to 
regular text.

3.  Open the document Diary4March. Use the Font dialog box and Effect, Hidden 
in order to hide all the text between the two dates. (You can unhide it again by 
selecting this part of the document and using the Font dialog box once more – 
experiment!) 

	 Can you think of any other way of ‘hiding’ text? Do this with the heading at the top.

When you rest the 
mouse (without clicking) 
on a command in 
the Font group, the 
keyboard shortcut is 
displayed in a tooltip for 
that command.

Hints for font choice 

With all the different fonts available, it is easy to overdo things when it comes to the 
choice of fonts. Bear the following in mind:

•	 A document looks at its best and makes a good impression if you use a maximum of 
2 or 3 font types. Limit the use of many different fonts types in your document. Rather 
use size variations and different styles, such as bold and italic, for emphasis. 

•	 Ensure that the font you choose matches the tone and content of the document. 
	 Courier looks old fashioned and is probably not appropriate for 

an advert for your school fete. It would be better suited to an 
article on the Second World War.  
Comic Sans MS would be appropriate for a party invitation. 

•	 For long pieces of text rather use simple fonts (e.g. Arial, Calibri, Verdana) because 
they are more legible. (Decorative fonts can be used for short headings but not for 
long pieces of text.)
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It is very important that information is easy to read and understand, and that the 
type of font used is suitable for the type of document. Open each of the following 
documents: Invoice, Testimonial and Menu. 

Change the font type and size of the documents to improve legibility. Make sure that 
the font type is suitable for the document. 

Activity 5

Test and improve your knowledge and skills

Overview of module 

Character 
appearance:

Font type, size, 
style

Colour, highlight, 
shrink font, 

strikethrough,
superscript and 

subscript

Change case, and 
other effects

What is 
a word 

processor?

What is 
a word 

processor 
used for?

Starting with Word

Working with 
documents:

Create

Save

Open

Display

Print

Working with text

Character formattingTyping

Word wrap

Correcting 
typing 

mistakes

Use of keys:

Enter 

Space bar

Tab

Punctuation 
marks

Symbols 

Hidden 
symbols

Selecting 
characters / 

text

Word wrap Text flows automatically from one line to the next, without the need to 
press <Enter>. It ‘wraps’ from the end of one line to the beginning of the 
next in a paragraph. 

Format To change the appearance, in other words to change how it looks on the 
screen or on paper.

Readability A document is readable when it has been set up so as to be easy for 
someone to read it and to find information on it. 

Save As When you save an existing document under a new name and/or in a new 
location (drive/folder).

Save When you have changed an existing document and you save it under the 
same name and in the same location.

Important terms and concepts
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Tips and recommendations
Spacing

•	 Use the Enter key only at the end of a paragraph. Long pieces of text (sentences) 
will wrap to the next line automatically as you type.

•	 Use only one space between words.

•	 Always add a space after a punctuation mark, but never before it.

Fonts

•	 A document creates the best impression if it contains a maximum of 2 or 3 font 
types. So limit the use of different fonts.

•	 Choose a font that suits the type of document.

•	 Avoid typing body text in uppercase. It is difficult to read. 

•	 Use standard familiar fonts for long sections of text, as this improves readability. 
Decorative fonts can be used for headings.

•	 For ordinary typed documents a font size of 10–12 pt is normally used.

Keyboard shortcuts

You should at least be using the following keyboard shortcuts already:

<Ctrl><S> 	 Save

<Ctrl><B> 	 Bold  

<Ctrl><A> 	 Selects all the content in a document

<Ctrl><Z>	 Undo

Written module activity

1.	 Why should you ‘preview’ a document before you print it?

2.	 Give two situations in which you would use the ‘Save as’ option rather than the 
‘Save’ option when saving a Word document .

3.	 Explain to someone the correct use of the Enter key in typing a document.

4.	 Someone sent you a long document with all the text typed in uppercase. What 
is the quickest way to correct this?

5.	 Distinguish between a Serif and a Sans Serif font. Also give one example of 
each.

6.	 What character sizes are generally suitable for ordinary text in an A4 
document?

7.	 Name two keyboard shortcuts that you often use, and state what each is used 
for.

8.	 Examine the following extract and describe the spacing and formatting errors 
that have been made. In each case give the correct spacing/formatting 
procedure. 
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1.	Someone recorded the highlights of each school day over a few days. Bring a 
diary up to date.

•	 Open the document Diary and complete it to look like the example on the 
next page.

•	 The specific font type or size does not matter, provided that the text 
appears larger and/or in a different font type where necessary.

2.	 Open the document Hectic_Day. 

	 In this document a number of formatting and spacing errors have been made. 
Find and correct these errors.

Practical module activity
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